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Getting Started 
The EOP ASSIST Interactive Workbook (Interactive Workbook) was released by the REMS TA Center in 
September 2015 in order to expand the reach of the EOP ASSIST software application to schools and 
districts that prefer use of an offline version of the tool. The Interactive Workbook is accessible via 
Microsoft Word—with or without an Internet connection—and includes the same content of the Web-
accessible version, including a blend of guidance and interactive forms that prompt users through the 
six-step planning process to develop a high-quality school emergency operations plan (EOP), as well as 
related resources to support that process. This workbook is available for download from the REMS 
Website (rems.ed.gov). Educational entities are welcome to further distribute the workbook to 
supplement and complement their capacity-building efforts. 

The Interactive Workbook includes two parts: (A) instructions, which is this document, and (B) 
worksheets for inputting plan information. Please be sure that you have both parts of the Interactive 
Workbook before continuing.  

For any questions about how to use the Interactive Workbook, please contact the REMS TA Center Help 
Desk using our toll-free telephone number, 1-855-781-REMS [7367]. Our hours of operation are Monday 
to Friday, 9 a.m. to 5 p.m., Eastern Time. If you are prompted to leave a voice message, we will respond 
within 2 business days of receipt. Alternatively, you may email info@remstacenter.org, or complete a TA 
request form at http://rems.ed.gov/TA_Submissions/.   

  

http://www.rems.ed.gov/
mailto:info@remstacenter.org
http://rems.ed.gov/TA_Submissions/
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Introduction 
Before Using the Interactive Workbook 
Based on the Federal Guide for Developing High-Quality School Emergency Operations Plans (School 
Guide), the Interactive Workbook walks school and district emergency management practitioners 
through the six-step planning process for creating a customized and downloadable school EOP as 
recommended in the School Guide. 

Before initiating the process of developing a school EOP, it is recommended that Interactive Workbook 
users familiarize themselves with the School Guide by completing any or all of the following activities: 

• Download and print a copy of the School Guide at http://rems.ed.gov/GuideK12.aspx. It will be 
useful to refer to this as you progress throughout the tool. 

• Read the At-a-Glance version of the School Guide at 
http://rems.ed.gov/K12GuideForDevelHQSchool.aspx.  

• View an archived Webinar that introduces and summarizes the School Guide through both slides 
and a video. This Webinar is available at http://rems.ed.gov/DevelopingHigh-
QualityEmergencyOperationsPlans.aspx. 

• Complete a free 90- to 120-minute online course on the School Guide, available at 
http://rems.ed.gov/trainings/course_k12.aspx.  

• Request a free on-site training, Developing Emergency Operations Plans (EOPs) K-12 101 
Training, from the REMS TA Center, for your school, district, and/or broader school community. 
Training information may be found at http://rems.ed.gov/TA_TrainingsByRequest.aspx. 

In addition to becoming acquainted with the Federal guidance on the process for developing school 
EOPs, it is also recommended that Interactive Workbook users review additional school emergency 
management resources, including the following: 

• State-by-state requirements for school EOPs, available at 
http://rems.ed.gov/stateresources.aspx; 

• A glossary of emergency management terminology, available at 
http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf; 

• Guidance on National Incident Management System (NIMS) Implementation Activities for 
Schools, available at http://rems.ed.gov/K12NIMSImplementation.aspx; and 

• A list of resources supporting the School Guide, which includes resources to support each of the 
six steps in the recommended planning process. This list of resources is available at 
http://rems.ed.gov/docs/Guide_for_Developing_High-
Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf. 

http://rems.ed.gov/GuideK12.aspx
http://rems.ed.gov/GuideK12.aspx
http://rems.ed.gov/K12GuideForDevelHQSchool.aspx
http://rems.ed.gov/DevelopingHigh-QualityEmergencyOperationsPlans.aspx
http://rems.ed.gov/DevelopingHigh-QualityEmergencyOperationsPlans.aspx
http://rems.ed.gov/trainings/course_k12.aspx
http://rems.ed.gov/TA_TrainingsByRequest.aspx
http://rems.ed.gov/stateresources.aspx
http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf
http://rems.ed.gov/K12NIMSImplementation.aspx
http://rems.ed.gov/docs/Guide_for_Developing_High-Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf
http://rems.ed.gov/docs/Guide_for_Developing_High-Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf
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How Teams Can Use the Interactive Workbook 
As lessons learned from experience indicate that operational planning is best performed by a team, 
Federal guidance recommends that schools assemble collaborative planning teams to work through the 
process of developing school EOPs. Effective planning teams have multidisciplinary representation from 
within the school community and from the community (e.g., local law enforcement, emergency 
managers). To encourage collaboration among team members, the Interactive Workbook has been 
designed to allow multiple members from a team to work together. Suggestions for how teams might 
work together using the workbook are outlined below. 

Suggestions for using the Interactive Workbook as a team: 

• Assemble a preliminary planning team. 
• Review the Interactive Workbook as a team to understand the nature of this tool. 
• Decide how your team will use the Interactive Workbook. Because the Interactive Workbook 

allows multiple team members to input plan information for a school EOP, your team will need 
to decide how to record plan information into the workbook. Will your team select one person 
to record plan information, or will multiple people record plan information? 

• Coordinate your team’s efforts in using the Interactive Workbook. If your team decides that 
multiple people will input information into the Interactive Workbook, then your team should 
identify roles and responsibilities for each person on the team who is using the workbook. 
Additionally, multiple users should coordinate their efforts so that one user does not 
accidentally change another user’s work. 

Introduction to the Planning Process 
The following planning principles are fundamental to developing a comprehensive school EOP that 
addresses a range of threats and hazards: 

• Planning must be supported by leadership. 
• Planning uses assessment to customize plans to the building level. 
• Planning considers all threats and hazards. 
• Planning provides for the access and functional needs of the whole school community.1 
• Planning considers all settings and all times. 
• Creating and revising a model EOP is done by following a collaborative process. 

                                                
 
1 The whole school community includes children; individuals with disabilities and other access and 
functional needs; those from religiously, racially, and ethnically diverse backgrounds; and people with 
limited English proficiency (LEP). 
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These planning principles are integrated throughout the School Guide’s recommended six-step planning 
process for developing a high-quality school EOP, as documented in Figure 1. 

Figure 1: Six-Step Planning Process for Developing a High-Quality School EOP 

 

This workbook is organized according to those six steps, and will walk users through each step to create 
a comprehensive school EOP that includes a Basic Plan2 section, a Functional Annexes3 section, and a 
Threat- and Hazard-Specific Annexes4 section. 

To initiate the planning process, please proceed to Step 1. For additional information and guidance on 
developing high-quality school EOPs, please see the following resources below. 

Supplemental Resources 
Guidance 
U.S. Department of Education (ED) Office of Safe and Healthy Students (OSHS) (June 2013). Guide for 
Developing High-Quality School Emergency Operations Plans. Available at 
http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf 

                                                
 
2 The Basic Plan section provides an overview of the school’s approach to operations before, during, and 
after an emergency. 
3 The Functional Annexes section focuses on critical operational functions and the goals, objectives, and 
courses of action developed to carry them out. 
4 The Threat- and Hazard-Specific Annexes section describes the goal, objectives, and courses of action 
for addressing particular threats and hazards. 

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
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• Page 4: Planning Principles 
• Page 5: Planning Process 
• Page 18: School EOP Format 

 
REMS TA Center. 

• School Guide At-a-Glance. Available at http://rems.ed.gov/K12GuideForDevelHQSchool.aspx. 
• Step 1: Form a Collaborative Planning Team. Available at http://rems.ed.gov/K12PPStep01.aspx. 
• Planning Principles. Available at http://rems.ed.gov/K12PlanningPrinciples.aspx. 
• The Planning Process. Available at http://rems.ed.gov/K12PlanningProcess.aspx. 
• Plan Content. Available at http://rems.ed.gov/K12PlanContent.aspx. 

REMS TA Center Resources 
• An Overview of the School Guide Webinar. Available at http://rems.ed.gov/DevelopingHigh-

QualityEmergencyOperationsPlans.aspx. 
• Developing Emergency Operations Plans 101 Online Course. Available at 

http://rems.ed.gov/trainings/course_k12.aspx. 
• Overview of the Six-Step Planning Process Specialized Training Package. Available at 

http://rems.ed.gov/TrainingPackage.aspx. 
• Planning Principles Related Resources. Available at 

http://rems.ed.gov/K12PlanningPrinciples.aspx. 
• Developing Emergency Operations Plans K-12 101 Train-the-Educator or Train-the-Trainer 

Training. Available at http://rems.ed.gov/TA_TrainingsByRequest.aspx. 
• State-by-State Requirements for School EOPs. Available at 

http://rems.ed.gov/stateresources.aspx. 
• Glossary of Emergency Management Key Terms. Available at 

http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf. 
• NIMS Implementation. Available at http://rems.ed.gov/K12NIMSImplementation.aspx. 
• Resources Supporting the School Guide. Available at 

http://rems.ed.gov/docs/Guide_for_Developing_High-
Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf. 

Additional Resources 
International Association of Chiefs of Police (IACP). Forming Your Safe School Planning Team Online 
Course. Available at http://elearning-
courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2.  

U.S. Department of Justice (DOJ) Office of Community-Oriented Policing Services (COPS). Collaboration 
Toolkit: How to Build, Fix, and Sustain Productive Partnerships. Available at 
http://www.cops.usdoj.gov/Default.asp?Item=2483.  

http://rems.ed.gov/K12GuideForDevelHQSchool.aspx
http://rems.ed.gov/K12PPStep01.aspx
http://rems.ed.gov/K12PlanningPrinciples.aspx
http://rems.ed.gov/K12PlanningProcess.aspx
http://rems.ed.gov/K12PlanContent.aspx
http://rems.ed.gov/DevelopingHigh-QualityEmergencyOperationsPlans.aspx
http://rems.ed.gov/DevelopingHigh-QualityEmergencyOperationsPlans.aspx
http://rems.ed.gov/trainings/course_k12.aspx
http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/K12PlanningPrinciples.aspx
http://rems.ed.gov/TA_TrainingsByRequest.aspx
http://rems.ed.gov/stateresources.aspx
http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf
http://rems.ed.gov/K12NIMSImplementation.aspx
http://rems.ed.gov/docs/Guide_for_Developing_High-Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf
http://rems.ed.gov/docs/Guide_for_Developing_High-Quality_School_Emergency_Operations_Plans-Resources07172013R.pdf
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2
http://www.cops.usdoj.gov/Default.asp?Item=2483
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Step 1: Form a Collaborative Planning Team 
Lessons learned indicate that operational planning is best performed by a team. Step 1 of the six-step 
planning process will provide your school with guidance on how to assemble a collaborative planning 
team that is ready to engage in the process of developing a school EOP. 

Identify a Core Planning Team 

Your school’s first task is to identify a core planning team that includes diverse representation from the 
school and surrounding community. If your school already has a preliminary planning team, the 
guidance in this section may help schools consider how to expand or refine that team. 

Form a Common Framework and Define and Assign Roles and Responsibilities 

After establishing a core planning team, your team will need to establish a common framework, or a 
shared approach to facilitate mutual understanding among team members. Additionally, members of 
the planning team will need to know their roles and responsibilities to facilitate effective planning. 

Determine a Regular Schedule of Meetings 

Finally, your team will be prompted to establish a regular schedule of meetings to facilitate greater 
collaboration among team members. 

Outcome of Step 1 

At the conclusion of Step 1, your school should have a collaborative planning team that is ready to 
undertake the work in Step 2—identifying and analyzing threats and hazards in the school and 
surrounding community. 

Identify a Core Planning Team 
A high-quality plan is supported by a collaborative process that includes multiple perspectives. The 
planning team should include representation from various stakeholder groups in the community that 
may be involved before, during, or after an emergency. The stakeholder groups may be represented 

• in person, by individuals who are physically or virtually present at planning meetings; 
• through consultation, by individuals who assist the planning team, from time to time, on specific 

matters; and/or 
• through incorporation of their resources, by individuals and organizations who provide relevant 

resources, but who are not regularly in contact with members of the planning team. 

The Federal guidance recommends that planning team members represent different stakeholder 
groups. Examples of those groups and the types of practitioners represented by those groups are as 
follows: 
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• School district or Local Education Agency; 
o Superintendent 
o District law enforcement, safety, security, and emergency management staff 
o School board representatives 
o District-level policymakers responsible for providing resources regarding before, during, 

or after an emergency 
• School community; 

o School leadership 
o School administrators 
o Educators 
o School Psychologists 
o School Counselors 
o Nurses 
o Facilities managers, maintenance personnel, and custodial staff 
o Transportation managers 
o Food personnel 
o Family services representatives 
o Families 
o School Resource Officers (SROs)/school-based safety and security officers 
o Students 
o Information Technology (IT) specialists 

• Individuals and organizations representing the diverse interests of the whole school community; 
o Students, staff, or parents with disabilities or other access and functional needs 
o Students, staff, or parents who are racial or ethnic minorities 
o Students, staff, or parents who belong to religious organizations 
o Students, staff, or parents with limited LEP 

• Local community partners with a responsibility in school emergency management and with 
information on the community; 

o Local emergency management staff 
o Emergency medical services (EMS) personnel 
o Fire officials 
o Local and community mental health practitioners 
o Law enforcement officers 

• State Department of Education or State Education Agency (SEA); 
o SEA emergency management staff 
o State School Safety Center staff 
o School safety advisory committees 

• State community partners; and/or 
o State emergency management and homeland security officials 
o State law enforcement officers, including field office staff of the Federal Bureau of 

Investigation (FBI); U.S. Drug Enforcement Administration; Bureau of Alcohol, Tobacco, 
Firearms and Explosives, etc. 

o Staff from the state department of fire or state fire marshal 
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o State department of health staff, including staff that are responsible for public and 
mental health 

• Additional partners with a role in school emergency management. 
o Policymakers and local elected officials 
o Business partners 
o Community-based religious organizations 
o Community-based youth organizations 
o Federal emergency management and homeland security officials 
o District and State Attorney General 
o Disaster organizations (e.g., American Red Cross) 
o Local social services departments  
o Media 

Action Steps 
At this point in the planning process, who is currently on your school’s planning team? Use Worksheet 1 
(pg. 5 in Part B) to identify the members of your team and the stakeholder groups represented by your 
team. If your team has already identified the members of your planning team and wishes to modify any 
of their information or remove a team member from the list, you may do so at any time. If your school’s 
planning team does not include sufficient representation from various stakeholder groups in the 
community (that may be involved in an emergency before, during, or after an incident), the core 
planning team may want to consider adding additional members to the collaborative planning team. 

You will need to add each team member one by one into the form in Worksheet 1 (pg. 5 in Part B). To 
add a team member, please type that person’s name and contact information into the corresponding 
fields and then enter the appropriate stakeholder category each person represents. Enter multiple 
stakeholder groups if the person represents more than one. Repeat this process as many times as 
necessary to add all members of the planning team into Worksheet 1. When you are finished, save your 
work (File>Save or CTRL+S). 

Form a Common Framework and Define and Assign Roles and Responsibilities 
After the planning team has been formed, the team members should form a common framework by 
taking time to learn each other’s vocabulary, command structure, and culture. Organizational 
differences may affect the expectations of different members of the planning team, so it is important to 
acknowledge these differences at the start of a collaborative process. For example, schools often 
operate according to an academic calendar and daily schedule that differ from a typical business or 
government calendar and daily schedule. Establishing a common understanding about different 
planning team members’ availability and schedules will help to facilitate effective planning and 
collaboration. 

By establishing a common framework, team members will also be able to communicate more effectively 
with one another. One common framework that is particularly effective in the context of school 
emergency management is NIMS. Developed by the U.S. Department of Homeland Security, NIMS is a 
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standardized approach used by Federal, state, and local agencies—including K-12 schools—for 
responding to emergencies. One important component of NIMS is the Incident Command System (ICS), 
which clearly defines the command structure used in an emergency. School personnel need to be 
trained in NIMS and their role in Incident Command in order to more effectively work with the 
responders in their communities. Using the framework of NIMS beginning in the EOP planning process 
will not only help members of the planning team communicate with one another, but will also help the 
team develop high-quality plans that can be clearly understood by responders who are not members of 
the planning team. 

In addition to forming a common framework, your planning team should take time to define and assign 
roles and responsibilities for each person involved in the development and refinement of the plan. This 
will help to facilitate greater coordination among team members. 

Determine a Regular Schedule of Meetings 
School emergency management planning is an ongoing effort that is reinforced through regularly 
scheduled planning meetings. Establishing a flexible but regular schedule of meeting times will facilitate 
greater collaboration, coordination, and communication among team members, and will help solidify 
crucial relationships. 

Often, planning teams that are creating new school EOPs will have to meet frequently initially. Once the 
EOP is in place, teams will still need regular meetings to revise and maintain the plan. Planning teams 
typically continue to meet often—at least once a month—to discuss plan modifications, plan and review 
trainings and drills, and conduct inventories of supplies. 

Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 5–7: Step 1 
 

REMS TA Center. Step 1: Form a Collaborative Planning Team. Available at 
http://rems.ed.gov/K12PPStep01.aspx. 

REMS TA Center Resources 
• Developing High-Quality School EOPs: A Collaborative Process Webinar. Available at 

http://rems.ed.gov/DevelopingHQSchoolEOPs.aspx. 
• Glossary of Emergency Management Key Terms. Available at 

http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf. 
• Integrating the Needs of Students and Staff With Disabilities and Other Access and Functional 

Needs Specialized Training Package. Available at http://rems.ed.gov/TrainingPackage.aspx. 
• NIMS Implementation. Available at http://rems.ed.gov/K12NIMSImplementation.aspx. 
• Step 1 Related Resources. Available at http://rems.ed.gov/K12PPStep01.aspx. 

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep01.aspx
http://rems.ed.gov/DevelopingHQSchoolEOPs.aspx
http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf
http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/K12NIMSImplementation.aspx
http://rems.ed.gov/K12PPStep01.aspx
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• Toolbox. Available at http://rems.ed.gov/ToolBox.aspx.  
o Documents supporting NIMS implementation 

Additional Resources 
DOJ COPS (2001). Collaboration Toolkit: How to Build, Fix, and Sustain Productive Partnerships. Available 
at http://www.cops.usdoj.gov/html/cd_rom/collaboration_toolkit/pubs/collaborationtoolkit.pdf. 

IACP. Forming Your Safe School Planning Team Online Course. Available at http://elearning-
courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2. 

U.S. Department of Homeland Security (DHS) Federal Emergency Management Agency (FEMA). 
• Introduction to the Incident Command System for Schools Online Course. Available at 

http://training.fema.gov/is/courseoverview.aspx?code=IS-100.SCa. 
• National Incident Management System. Available at http://www.fema.gov/national-incident-

management-system. 
• National Incident Management System (December 2008). Available at 

http://www.fema.gov/pdf/emergency/nims/NIMS_core.pdf. 
o Pages 135–149: Glossary of Key Terms 

  

http://rems.ed.gov/ToolBox.aspx
http://www.cops.usdoj.gov/html/cd_rom/collaboration_toolkit/pubs/collaborationtoolkit.pdf
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=2
http://training.fema.gov/is/courseoverview.aspx?code=IS-100.SCa
http://www.fema.gov/national-incident-management-system
http://www.fema.gov/national-incident-management-system
http://www.fema.gov/pdf/emergency/nims/NIMS_core.pdf
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Step 2: Understand the Situation 
Now that your school has a collaborative planning team, it is time to begin the process of developing 
your school’s EOP. Step 2 will prompt your team to complete a series of activities to develop a 
comprehensive, yet prioritized list of threats and hazards to be addressed in the school EOP. 

Develop a Comprehensive List of Possible Threats and Hazards Using a Variety of Data Sources 

Your team’s first task is to develop a comprehensive list of threats and hazards by consulting a variety of 
data sources, including school and district assessment data; information from local, state, and Federal 
partners; and information from the school community. 

Evaluate Risks and Vulnerabilities of Threats and Hazards and Then Prioritize 

After your team develops a comprehensive list of possible threats and hazards, the team should 
evaluate the risk and vulnerability of each of the threats and hazards. This evaluation will help your 
planning team to prioritize and refine the list of threats and hazards that will be addressed in your 
school EOP. 

Outcome of Step 2 

At the conclusion of Step 2, your planning team should have a prioritized list of threats and hazards that 
will be carried forward to Step 3. In Step 3, your planning team will begin developing response measures 
to address those prioritized threats and hazards. 

Develop a Comprehensive List of Possible Threats and Hazards Using a Variety of 
Data Sources 
Your team’s first task is to develop a comprehensive list of threats and hazards by consulting a variety of 
data sources. Different data sources that may provide information on threats and hazards in your school 
and community are as follows: 

• Data from school and district assessments. Your school and/or district should regularly conduct 
assessments to learn information about safety and security in your school. The data generated 
from each of the following types of assessments may provide critical information about threats 
and hazards in your school community. 

o Site Assessment 
 Description: A site assessment examines the safety, accessibility, and 

emergency preparedness of the school’s buildings and grounds. This assessment 
includes, but is not limited to, the following: a review of building access and 
egress control measures, visibility around the exterior of the building, structural 
integrity of the building, compliance with applicable architectural standards for 
individuals with disabilities and other access and functional needs, and 
emergency vehicle access. 
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 Purpose: To increase understanding of the potential impact of threats and 
hazards on the school buildings and grounds; the risks and vulnerabilities of the 
school buildings and grounds; and which facilities are physically accessible to 
students, staff, parents, volunteer workers, and emergency response personnel 
with disabilities (and thus are in compliance with the law). 

o Culture and Climate Assessment 
 Description: A school culture and climate assessment evaluates student and 

staff connectedness to the school and problem behaviors. For example, this 
assessment may reveal a high number of bullying incidents, indicating a need to 
implement an anti-bullying program. If a student survey is used to assess culture 
and climate, student privacy must be protected. 

 Purpose: To increase knowledge of students’ and staff members’ perceptions of 
their safety and of problem behaviors that need to be addressed to improve 
school climate. 

o School Threat Assessment 
 Description: A school threat assessment analyzes communication and behaviors 

to determine whether or not a student, staff member, or other person may 
pose a threat. These assessments must be based on fact; must comply with 
applicable privacy, civil rights, and other applicable laws; and are often 
conducted by multidisciplinary threat assessment teams. While a planning team 
may include the creation of a threat assessment team in its plan, the 
assessment team is a separate entity from the planning team and meets on its 
own regular schedule. 

 Purpose: To identify students, staff, or other persons who may pose a threat—
before the threat develops into an incident—and to refer those individuals for 
services, if appropriate. 

o Capacity Assessment 
 Description: The planning team needs to know what resources will be at its 

disposal. A capacity assessment examines the capabilities of students and staff 
as well as the services and material resources of community partners. This 
assessment is used to identify people in the building with applicable skills (e.g., 
first aid certification, search and rescue training, counseling and mental health 
expertise, ability to assist individuals with disabilities and other access and 
functional needs). Equipment and supplies should also be inventoried. The 
inventory should include an evaluation of equipment and supplies uniquely for 
individuals with disabilities, such as evacuation chairs, the availability of sign 
language interpreters and technology used for effective communication, 
accessible transportation, and consumable medical supplies and durable 
medical equipment that may be necessary during a shelter-in-place or 
evacuation. 
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 Purpose: To gain an increased understanding of the resources available and 
learn information about staff capabilities. This will help planners assign roles 
and responsibilities in the plan. 

• Information from local, state, and Federal partners. Your planning team should reach out to 
local,5 state,6 and Federal7 agencies for information about historical threats and hazards faced 
by the surrounding community. 

• Information from the school community. Your planning team should reach out to the broader 
school community to identify any additional threats and hazards that the school and 
surrounding community have faced in the past or may face in the future. 

Action Steps 
Please record threats and hazards from various data sources into the left-hand column in Worksheet 2 
(pg. 6–7). These threats and hazards may be modified at any time. When you are finished, save your 
work (File>Save or CTRL+S). 

Evaluate Risks and Vulnerabilities of Threats and Hazards and Then Prioritize 
After developing a comprehensive list of threats and hazards, and collecting information about those 
threats and hazards, the planning team should consolidate all of the information it has obtained into a 
format that is usable for evaluating and comparing the risks posed by the identified threats and hazards. 
This will allow the team to prioritize which threats or hazards it will directly address in the plan. 

In order to evaluate the risk and vulnerability of a particular threat or hazard, your team should depict 
scenarios of each threat and hazard unfolding at your school and consider the risk criteria of magnitude, 
duration, probability, and warning time associated with the threat or hazard, as well as how different 
variables could affect the different risk criteria. For example, consider how the warning time for a school 
fire might differ if the cause of the fire is a wildfire spreading across a nearby forest versus an accidental 
explosion in a science lab. At this stage in the planning process, it is suggested that your planning team 
err on the side of caution in determining risk and identifying vulnerabilities. 

                                                
 
5 Examples of local and county agencies include the following: emergency management offices, fire and 
police departments, local organizations and community groups (e.g., local chapter of the American Red 
Cross, Community Emergency Response Team), and utility companies. 
6 Examples of state agencies include state Departments of Education, Homeland Security and/or 
Emergency Management, and Health; Fire Marshal; and State Police. 
7 Examples of Federal agencies include U.S. Department of Homeland Security and FEMA; DOJ and FBI; 
ED; U.S. Department of Health and Human Services; the National Oceanic and Atmospheric 
Administration; and U.S. Geological Survey. 
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One way to evaluate risk is to use a mathematical approach that assigns index numbers (e.g., a 1-to-4 
scale) for different categories of information used in the ranking scheme. Using this approach, the 
planning team may categorize threats and hazards as posing a relatively high, medium, or low risk.  

Action Steps 
To evaluate the risk of each of your threats and hazards using this approach, please assign the 
appropriate index numbers for each risk category included in the five middle columns of Worksheet 2 
(pg. 6–7) for each of the threats and hazards you previously identified in the left-hand column.  

Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 7–12: Step 2 
 
REMS TA Center. 

• Step 2: Understand the Situation. Available at http://rems.ed.gov/K12PPStep02.aspx. 
• School Climate and Emergencies. Available at 

http://rems.ed.gov/K12SchoolClimateAndEmerg.aspx. 
 

REMS TA Center Resources 
• Examples of Threats and Hazards. Available at 

http://try.eopassist.remstacenter.org/resources/Examples%20of%20Threats%20and%20Hazard
s.pdf. 

• Threat Assessment in Schools: Basic and Benchmarks Train-the-Educator Training (Free On-site 
Training by Request). Available at http://rems.ed.gov/TA_TrainingsByRequest.aspx. 

• Step 2 Related Resources. Available at http://rems.ed.gov/K12PPStep02.aspx. 
• School Climate and Emergencies Related Resources. Available at 

http://rems.ed.gov/K12SchoolClimateAndEmerg.aspx. 
• Integrating the Needs of Students and Staff With Disabilities and Other Access and Functional 

Needs Specialized Training Package. Available at http://rems.ed.gov/TrainingPackage.aspx. 
• Tool Box. Available at http://rems.ed.gov/ToolBox.aspx. 

o Assessment Materials and Surveys 
o Assessment Checklists/Worksheets 

Additional Resources 
IACP. Assessing School Safety Online Course. Available at http://elearning-
courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=3. 
 
  

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep02.aspx
http://rems.ed.gov/K12SchoolClimateAndEmerg.aspx
http://try.eopassist.remstacenter.org/resources/Examples%20of%20Threats%20and%20Hazards.pdf
http://try.eopassist.remstacenter.org/resources/Examples%20of%20Threats%20and%20Hazards.pdf
http://rems.ed.gov/TA_TrainingsByRequest.aspx
http://rems.ed.gov/K12PPStep02.aspx
http://rems.ed.gov/K12SchoolClimateAndEmerg.aspx
http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/ToolBox.aspx
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=3
http://elearning-courses.net/iacp/registrationPortal/courseInformation.cfm?courseID=3
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Step 3: Determine Goals and Objectives 
Now that your planning team has a comprehensive yet prioritized list of threats and hazards, Step 3 will 
prompt your team to select which threats and hazards will be included in the EOP, and then to develop 
goals and objectives for addressing those selected threats and hazards. 

Select Threats and Hazards to Address in the School EOP 

Your team’s first task is to review the prioritized list of threats and hazards from Step 2 and to select 
which of those threats and hazards will be addressed in the school EOP. 

Develop Goals and Objectives for Threats and Hazards 

Next, your planning team will develop three goals (before, during, and after) to address each selected 
threat and hazard, and then develop corresponding objectives for each goal. Some goals and objectives 
apply to multiple threats and hazards and are therefore considered cross-cutting functions. During the 
process of developing goals and objectives for threats and hazards, your team will also need to identify 
which goals and objectives are functions and which are not. 

Develop Goals and Objectives for Functions 

After identifying cross-cutting functions, your team will develop goals and objectives for each function. 

Outcome of Step 3 

At the conclusion of Step 3, your planning team will have developed goals and objectives for each 
threat, hazard, and function. These goals and objectives will be carried forward to Step 4 and will be 
used as the basis for courses of action. Goals, objectives, and courses of action will ultimately form the 
Functional Annexes and Threat- and Hazard-Specific Annexes of the school EOP. 

Select Threats and Hazards to Address in the School EOP 
Your team’s first task is to review the prioritized list of threats and hazards from Step 2 and to select the 
threats and hazards that your planning team chooses to address in the school EOP. These selected 
threats and hazards will be carried forward in the remaining steps of the planning process. 

Action Steps 
Worksheet 2 (pg. 6–7) contains a summary of the threats and hazards that your planning team 
identified, assessed for risk, and prioritized in Step 2. Please review this content carefully and then 
determine which threats and hazards your team will initially address in your school EOP. Once your 
team has decided which threats and hazards will be addressed, you should place a checkmark in the 
right-hand column of Worksheet 2 (pg. 6–7) for each selected threat and hazard. Save your work 
(File>Save or CTRL+S). 
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Goals are broad, general statements 
that indicate the desired outcome in 
response to the threat or hazard 
identified by planners in the 
previous step.  

Objectives are specific, measurable 
actions that are necessary to achieve 
the goals.  

These cross-cutting goals and 
objectives are known as functions. 

Develop Goals and Objectives for Threats and Hazards 
Next, your team should develop three goals and corresponding objectives for each of your selected 
threats and hazards. The three goals should indicate the desired outcome (1) before, (2) during, and (3) 
after a threat or hazard has unfolded at your school. For each of your goals, please provide 
corresponding objectives—or specific, measurable actions—to achieve these goals. Often, planners will 
need to identify multiple objectives in support of a single goal. The goals and objectives developed in 
this step will be carried forward to the next step in the planning process—Step 4—which will prompt 
your planning team to develop courses of action for accomplishing the goals and objectives established 
here. Ultimately, the goals, objectives, and courses of action developed for each threat and hazard will 
form the Threat- and Hazard-Specific Annexes section of your school EOP.  

As your team develops goals and objectives for threats and 
hazards, you should find that some of your goals and 
objectives apply to more than one threat or hazard. For 
example, a goal addressing the threat or hazard of a fire 
might be to provide necessary medical attention to those in 
need. Providing medical attention is a goal that could also 
apply to tornadoes, explosions, contaminated food 
outbreaks, or active-shooter situations. These cross-cutting 
goals and objectives are known as functions. Examples of 
functions include the following: evacuation; lockdown; 
shelter-in-place; accounting for all persons; communications 
and warning; family reunification; continuity of operations; recovery; public health, medical health, and 
mental health; and security. While developing goals and objectives, your team will be prompted to 
identify which of those goals and objectives are considered functions. The functions that your team 
identifies here will eventually become Functional Annexes in your school EOP. 

Sample Goals and Objectives 
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Action Steps 
Please use Worksheets 29–39 (pg. 35–45) to develop goals and objectives for each selected threat and 
hazard.  

Please use Worksheet 3 (pg. 8) to document any cross-cutting functions that are referred to in the goals 
and objectives developed for threats and hazards. 

Begin by typing the respective threat or hazard above the table. Then, type your goals and objectives 
into the designated table cells. You may add rows to the table (as you would with any other table in 
Microsoft Word) if your team needs to develop multiple objectives in support of a single goal. Then, for 
each goal and objective, use Worksheet 3 (pg. 8) to mark the checkbox for the corresponding function, 
as applicable.  

Recommended functions are preloaded on Worksheet 3 (pg. 8); however, your team may add new 
functions to the list on Worksheet 3 (pg. 8) as well. Once a function has been marked, it is not necessary 
to mark it again. Be sure to save your work (File>Save or CTRL+S). Repeat this process for the remaining 
threats and hazards. 

Develop Goals and Objectives for Functions 
After identifying functions, the planning team should develop three goals and corresponding objectives 
for each function. As with the goals already identified for threats and hazards, the three goals should 
indicate the desired outcome for (1) before, (2) during, and (3) after the function has been executed. 
The goals and objectives developed for these functions will be carried forward to the next step in the 
planning process—Step 4—which will prompt your planning team to develop courses of action for 
accomplishing the goals and objectives established here. Ultimately, the goals, objectives, and courses 
of action developed for each function will form the Functional Annexes section of your school EOP. 

Action Steps 
Please use Worksheets 18–28 (pg. 24–34) to develop goals and objectives for each selected function 
identified in Worksheet 3 (pg. 8). 

Directions for Developing Goals and Objectives for Recommended Functions 
Recommended functions are preloaded above each table in Worksheets 18–28 (pg. 24-34). To develop 
goals and objectives for those preloaded functions, find the appropriate worksheet for the function 
using the table that begins on the next page. Then, type your goals and objectives into the designated 
table cells. You may add rows to the table, if your team needs to develop multiple objectives in support 
of a single goal. Repeat this process for the remaining recommended functions. Be sure to save your 
work (File>Save or CTRL+S).  
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Recommended 
Function 

Considerations for Developing Goals, Objectives, and 
Courses of Action 

Corresponding 
Worksheet 

Evacuation • How to safely move students and visitors to 
designated assembly areas from classrooms, outside 
areas, cafeterias, and other school locations. 

• How to evacuate when the primary evacuation route 
is unusable. 

• How to evacuate students who are not with a 
teacher or staff member. 

• How to evacuate individuals with disabilities (along 
with service animals and assistive devices, e.g., 
wheelchairs) and others with access and functional 
needs, including language, transportation, and 
medical needs. 

Worksheet 18 (pg. 24) 

Lockdown • How to lock all exterior doors, and when it may or 
may not be safe to do so. 

• How particular classroom and building 
characteristics (i.e., windows, doors) impact possible 
lockdown courses of action. 

• What to do when a threat materializes inside the 
school. 

• When to use the different variations of a lockdown 
(e.g., when outside activities are curtailed, doors are 
locked, and visitors are closely monitored, but all 
other school activities continue as normal). 

Worksheet 19 (pg. 25) 

Shelter-in-Place • What supplies will be needed to seal the room and 
to provide for the needs of students and staff (e.g., 
water). 

• How a shelter-in-place can affect individuals with 
disabilities and others with access and functional 
needs, such as students who require the regular 
administration of medication, durable medical 
equipment, and personal assistant services. 

• How to move students when the primary route is 
unusable. 

• How to locate and move students who are not with a 
teacher or staff member. 

• Consider the need for and integration of “safe 
rooms” for protection against extreme wind hazards 
(such as a tornado or hurricane) in order to provide 
immediate life-safety protection when evacuation is 

Worksheet 20 (pg. 26) 
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not an option. 

Accounting for 
All Persons 

• How staff will determine who is in attendance at the 
assembly area. 

• What to do when a student, staff member, or guest 
cannot be located. 

• How staff will report to the assembly supervisor. 
• How and when students will be dismissed or 

released. 

Worksheet 21 (pg. 27) 

Communications 
and Warning 

• How the school’s communications system integrates 
into the local disaster and response law enforcement 
communication networks (e.g., fire department and 
law enforcement staff). 

• How to ensure relevant staff members can operate 
communications equipment. 

• How the school will communicate with students, 
families, and the broader community before, during, 
and after an emergency. 

• How to account for technology barriers faced by 
students, staff, parents, and guardians. 

• How to effectively address language access barriers 
faced by students, staff, parents, and guardians. 

• How the school will handle the media (e.g., district 
or school Public Information Officer [PIO]). 

• How impacts on students will be communicated to 
the community, including the impact on activities 
related to the school but not necessarily at the 
school or during regular school hours (i.e., church 
use of school property and athletic events). 

• How the school will ensure effective communication 
with individuals with disabilities and others with 
access and functional needs (e.g., coordinating with 
first responders and local emergency managers to 
provide sign language interpreters for use during 
press conferences, publishing only accessible 
documents, ensuring information on websites is 
accessible). 

Worksheet 22 (pg. 28) 

Family 
Reunification 

• How to inform families and guardians about the 
reunification process in advance, and how to clearly 
describe their roles and responsibilities in 
reunification. 

• How to verify that an adult is authorized to take 

Worksheet 23 (pg. 29) 
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custody of a student. 
• How to facilitate communication between the 

parent check-in and the student assembly and 
reunion areas. 

• How to ensure students do not leave on their own. 
• How to protect the privacy of students and parents 

from the media. 
• How to reduce confusion during the reunification 

process. 
• How frequently families will be updated. 
• How to account for technology barriers faced by 

students, staff, parents, and guardians. 
• How to effectively address language access barriers 

faced by students, staff, parents, and guardians. 

Continuity of 
Operations 
(COOP) 

• How the COOP annex will be designed so that it can 
be activated at any time and sustained for up to 30 
days. 

• How the COOP annex will set priorities for re-
establishing essential functions, such as restoration 
of school operations, and maintaining the safety and 
well-being of students and the learning 
environment. 

• How the COOP annex will ensure students receive 
applicable related services in the event of a 
prolonged closure. 

Worksheet 24 (pg. 30) 

Recovery • Academic recovery 
• When the school should be closed and reopened, 

and who has the authority to do so. 
• What temporary space(s) the school may use if 

school buildings cannot be immediately reopened. 
• How to provide alternate educational programming 

in the event that students cannot physically 
reconvene. 

• Physical recovery 
• How to document school assets, including physically 

accessible facilities, in case of damage. 
• Which personnel have expert knowledge of the 

schools’ assets, and how and where they will access 
records to verify current assets after disaster strikes. 

• How the school will work with utility and insurance 
companies before an emergency to support a 

Worksheet 25 (pg. 31) 
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quicker recovery. 
• Fiscal recovery 
• How district leadership will be included (e.g., 

superintendent, chief business officer, personnel 
director, and risk manager). 

• How staff will receive timely and factual information 
regarding returning to work. 

• What sources the school may access for emergency 
relief funding. 

• Psychological and emotional recovery 
• Who will serve as the team leader. 
• Where counseling and psychological first aid will be 

provided. 
• How teachers will create a calm and supportive 

environment for the students, share basic 
information about the incident, provide 
psychological first aid (if trained), and identify 
students and staff who may need immediate crisis 
counseling. 

• Who will provide trained counselors. 
• How to address the immediate, short-, and long-

term counseling needs of students, staff, and 
families. 

• How to handle commemorations, memorial 
activities, or permanent markers and/or memorial 
structures (if any will be allowed). This includes 
concerns such as when a commemoration site will 
be closed, what will be done with notes and tributes, 
and how students will be informed in advance. 

• How memorial activities will strike a balance among 
honoring the loss, resuming school and class 
routines and schedules, and maintaining hope for 
the future. 

• How the Public Health, Medical and Mental Health 
annex will inform the actions and plans of the 
Recovery annex. 

Public Health, 
Medical, and 
Mental Health 

• What the role of staff members is in providing first 
aid during an emergency. 

• Where emergency medical supplies (e.g., first aid 
kits, AEDs) will be located and who is responsible for 
purchasing and maintaining those materials. 

• Which staff have relevant training or experience, 

Worksheet 26 (pg. 32) 
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such as in first aid or CPR. 
• How the school will secure a sufficient number of 

counselors in the event of an emergency. 
• How the school will promptly share and report 

information about outbreaks or epidemics or other 
unusual medical situations to the local health 
department. 

• How the school will support the needs of students 
identified by the threat assessment team. 

Security • How agreements with law enforcement agencies 
address the daily role of law enforcement officers in 
and around school. 

• How to make sure the building is physically secure 
(including implementation of Crime Prevention 
Through Environmental Design [CPTED]); 

• How to get students to and from school safely 
(including traffic control and pedestrian safety); 

• How to keep prohibited items out of school; and 
• How to respond to threats identified by the 

behavioral threat assessment team. 
• How information will be shared with law 

enforcement officers or other responders (keeping 
in mind any requirements or limitations of applicable 
privacy laws, including the Family Educational Rights 
and Privacy Act of 1974 [FERPA], the Health 
Insurance Portability and Accountability Act of 1996 
[HIPAA], and civil rights and other laws). For more 
information on FERPA and HIPAA, visit Information 
Sharing. 

Worksheet 27 (pg. 33) 

*Refer to this table again when developing courses of action for functions in Step 4. 

Directions for Developing Goals and Objectives for New Functions 
For any new functions identified on Worksheet 3 (pg. 8), use Worksheet 28 (pg. 34) to develop goals 
and objectives for those functions. Begin by identifying the number of new functions on Worksheet 3 
(pg. 8). There is one table on Worksheet 28 (pg. 34) for new functions. If your team has identified more 
than one new function, you will need to create additional worksheet content (the heading and the 
tables) for each of those functions. Simply copy (CTRL+C) the heading and table on Worksheet 28 (pg. 
34) and then paste (CTRL+V) as many times as there are new functions. For each new function table, 
begin by typing the name of the new function in the indicated space above the table (formatted as 
heading level 2). Then, type your goals and objectives into the designated table cells. You may add rows 
to the table if your team needs to develop multiple objectives in support of a single goal. Repeat this 
process for the remaining recommended functions. Be sure to save your work (File>Save or CTRL+S). 
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Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 12–14: Step 3 

REMS TA Center. Step 3: Determine Goals and Objectives. Available at 
http://rems.ed.gov/K12PPStep03.aspx. 

REMS TA Center Resources 
• Integrating the Needs of Students and Staff With Disabilities and Other Access and Functional 

Needs Specialized Training Package. Available at http://rems.ed.gov/TrainingPackage.aspx. 
• Step 3 Related Resources. Available at http://rems.ed.gov/K12PPStep03.aspx. 

  

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep03.aspx
http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/K12PPStep03.aspx
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Step 4: Plan Development (Identify Courses of Action) 
Now that your planning team has identified goals and objectives for addressing threats, hazards, and 
functions, Step 4 will prompt your team to develop courses of action for accomplishing those goals and 
objectives. Courses of action are the step-by-step procedures used to enact functions or manage threats 
and hazards. 

Use Scenario-Based Planning 

Your team’s first task in developing courses of action is to use scenario-based planning to imagine the 
different ways that a threat or hazard may unfold, and the steps your school and community partners 
should take to address those threats and hazards—either with functions or with threat- and hazard-
specific procedures. 

Develop Courses of Action for Threats and Hazards 

Next, using the scenarios that your planning team just imagined, your team will develop courses of 
action that clearly describe how your school and community partners will enact procedures to address 
specific threats and hazards. 

Develop Courses of Action for Functions 

Likewise, your planning team will use the scenarios to develop courses of action that clearly describe 
how your school and community partners will enact different functions. 

Outcome of Step 4 

At the conclusion of Step 4, your planning team will have courses of action for each threat, hazard, and 
function. Along with the goals and objectives developed in Step 3, the courses of action will form the 
primary content in the Functional Annexes and Threat- and Hazard-Specific Annexes sections of your 
school EOP. In Step 5, your team will format the goals, objectives, and courses of action into actual 
sections of the school EOP. 

Use Scenario-Based Planning 
Your team’s first task in developing courses of action is to use scenario-based planning to imagine the 
different ways that a threat or hazard may unfold, and how your school and community partners should 
address those threats and hazards—with functions or threat- or hazard-specific procedures. High-quality 
courses of action account for all possible ways that an emergency can unfold, including all settings and 
times. As such, your team should use scenarios to envision all of the variables that may impact how a 
threat or hazard unfolds. 

For example, imagine that there is a chemical spill near your school. How might the response measures 
change if this chemical spill happens at 7 a.m., 1 p.m., or 10 p.m.? Will a school’s response differ based 
on the time of day and the persons who are in the building? How might the response measures differ if 
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the chemical spill occurs outside of the school cafeteria, just before lunch? What if the spill 
contaminates the heating, ventilation, and air conditioning system before the start of the school day? 

To use scenario-based planning, planning teams are recommended to take the following steps: 

1. Depict a scenario involving a selected threat or hazard. 
2. Determine the amount of time available to respond to the threat or hazard in your scenario. 

This time will vary based on the type of threat or hazard and the particular scenario. 
3. Identify decision points. Decision points indicate the place in time, as threats or hazards unfold, 

when leaders anticipate making decisions about a course of action. 
4. Develop courses of action. Use the scenario, available response time, and decision points to 

determine appropriate courses of action. Additional information about developing courses of 
action is included on the next page. 

Develop Courses of Action for Threats and Hazards and for Functions 
Courses of action should read as a specific set of steps or instructions that individuals with different 
roles and responsibilities should take in order to accomplish established goals and objectives. Courses of 
action should provide answers to the following questions: 

• What is the action? 
• Who is responsible for the action? 
• When does the action take place? 
• How long does the action take and how much time is actually available? 
• What has to happen before? 
• What happens after? 
• What resources are needed to perform the action? 
• How will this action affect specific populations, such as individuals with disabilities and others 

with access and functional needs who may require medication, wayfinding, evacuation or 
personal assistance services, or who may experience severe anxiety during traumatic events? 
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Sample Courses of Action 

 

Action Steps 
It is now time to develop courses of action that address the threats and hazards and functions that your 
planning team selected for your school EOP in Step 3. As your team may recall, Step 3 also prompted 
your team to develop goals and objectives for threats and hazards as well as for functions. Those goals 
and objectives that your team developed may be found in Worksheets 29-39 (pg. 35–45) for threats and 
hazards, and Worksheets 18–28 (pg. 24–34) for functions.  

To develop courses of action for a threat, hazard, or function, find 
the specific threat, hazard, or function worksheet. Then in the 
designated cells in the table, write out courses of action that 
accomplish the goals and objectives that your team previously 
developed, and which address the questions listed above. Repeat 
this process for the remaining threats and hazards. Be sure to 
save your work (File>Save or CTRL+S). 

Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 14–16: Step 4 

REMS TA Center. Step 4: Plan Development (Identifying Courses of Action). Available at 
http://rems.ed.gov/K12PPStep04.aspx. 

When developing courses of 
actions for functions, refer to 
the table in Step 3, pages 19-24, 
regarding considerations for 
developing goals, objectives, 
and courses of action for 
functions. 

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep04.aspx
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REMS TA Center Resources 
• Integrating the Needs of Students and Staff With Disabilities and Other Access and Functional 

Needs Specialized Training Package. Available at http://rems.ed.gov/TrainingPackage.aspx. 
• Tool Box. Available at http://rems.ed.gov/ToolBox.aspx. 

o Scenarios for Use in Scenario-Based Planning 
o Emergency Procedures 

Additional Resources 
DHS FEMA (November 2010). Comprehensive Preparedness Guide 101: Developing and Maintaining 
Emergency Operations Plans, Version 2. Available at http://www.fema.gov/media-
library/assets/documents/25975. 

• Chapter 4, Pages 12–16: Information on Scenario-Based Planning   

http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/ToolBox.aspx
http://www.fema.gov/media-library/assets/documents/25975
http://www.fema.gov/media-library/assets/documents/25975
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Step 5: Plan Preparation, Review, and Approval 
Now that your planning team has completed all of the preparatory work for the school EOP, Step 5 will 
prompt your team to format this material into a plan. Although there are many ways to format an EOP, 
the Interactive Workbook will guide your team to create a plan with the following sections: (1) Basic 
Plan,8 (2) Functional Annexes,9 and (3) Threat- and Hazard-Specific Annexes.10 

Prepare the Draft EOP 

First, your planning team will need to create a draft of the school EOP, beginning with the Threat- and 
Hazard-Specific and Functional Annexes. At this stage, your team has already developed the content for 
these annexes—which includes the goals, objectives, and courses of action developed in Step 3 and Step 
4, and located in Worksheets 29–39 (pg. 35–45) and Worksheets 18–28 (pg. 24–34). In addition to the 
Threat- and Hazard-Specific and Functional Annexes, your team will also draft the Basic Plan section, 
which will be located in Worksheets 4–17 (pg. 9–23). If your school is part of a larger school district, 
some of the content for this section may come from the district.  

Format the Draft EOP 

After your team has developed content for the Basic Plan, the Functional Annexes, and the Threat- and 
Hazard-Specific Annexes of your school EOP, your team will need to format your worksheets into a 
school EOP. 

Review, Approve, and Share the Plan 

After your planning team has finished formatting the draft EOP, your team will review11 this draft for 
both plan content and writing conventions, and revise the plan accordingly. After reviewing the draft 
                                                
 
8 The Basic Plan section of the school EOP provides an overview of the school’s approach to emergency 
operations. Although the Basic Plan section guides the development of the more operationally oriented 
annexes, its primary audiences consist of the school, local emergency officials, and the community (as 
appropriate). 
9 The Functional Annexes section details the goals, objectives, and courses of action of functions (e.g., 
evacuation, lockdown, recovery) that apply across multiple threats or hazards. Functional annexes set 
forth how the school manages a function before, during, and after an emergency. 
10 The Threat- and Hazard-Specific Annexes section specifies the goals, objectives, and courses of action 
that a school will follow to address a particular type of threat or hazard (e.g., hurricane, active shooter). 
Threat- and hazard-specific annexes, like functional annexes, set forth how the school manages a 
function before, during, and after an emergency. 
11 Note: Your planning team will have to review the school EOP two different times in the six-step 
planning process, in Step 5 and Step 6. Here, in Step 5, your team is charged with reviewing a draft of the 
plan. In Step 6, your team will need to regularly review the published plan as part of regular plan updating 
and maintenance. These two types of reviews should not be confused with one another. 
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and revising the plan, your planning team must obtain official approval of the plan and then share the 
plan with community partners and additional stakeholders who may have a role in the plan. 

Outcome of Step 5 

At the conclusion of Step 5, your planning team will have an approved EOP that is ready to be 
implemented by your school. 

Prepare the Draft EOP: Threat- and Hazard-Specific Annexes and Functional 
Annexes 
Your planning team already completed most of the work for the Threat- and Hazard-Specific Annexes12 
and Functional Annexes13 in Step 3 and Step 4, when your team identified goals, objectives, and courses 
of action for threats and hazards. At this stage, your team will be prompted to edit the text already 
developed for each threat, hazard, and function and then format accordingly for inclusion in the draft 
EOP. A recommended format for presenting information in each of the annexes is as follows: 

• Title (the threat or hazard) 
• Goal(s) 
• Objective(s) 
• Courses of Action (Describe the courses of action you developed in Step 4 in the sequence in 

which they should occur.) 

Action Steps 
To edit and format the content for each of your annexes, please refer to Worksheets 29–39 (pg. 35–45) 
for Threat- and Hazard-Specific Annexes and Worksheets 18–28 (pg. 24–34) for Functional Annexes. 

 If you would like to maintain the table format for these annexes, please proceed to the review and 
revision of these annexes, described below.  

 If you would like to convert the text from the table format to a narrative format, please convert the 
table to text by following the steps listed below14: 

1. Select the table with your mouse. 
                                                
 
12 The Threat- and Hazard-Specific Annexes section specifies the goals, objectives, and courses of action 
that a school will follow to address a particular type of threat or hazard (e.g., hurricane, active shooter). 
Threat- and Hazard-Specific annexes, like functional annexes, set forth how the school manages a 
function before, during, and after an emergency. 
13 The Functional Annexes section details the goals, objectives, and courses of action of functions (e.g., 
evacuation, lockdown, recovery) that apply across multiple threats or hazards. Functional annexes set 
forth how the school manages a function before, during, and after an emergency. 
14 The following steps are written for Microsoft Word 2013. The steps may vary for different versions of 
Microsoft Word. 
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2. In the Microsoft Word toolbar, select Layout (Table Tools) > Convert to Text  
3. You will be presented with a pop-up box. Make sure that the Paragraph marks option is 

selected and that Convert nested tables is checked. 

After converting the table to text, revise the text as necessary.  

The aim of reviewing and revising your annexes is to develop coherent annexes. As you review and 
revise your Threat- and Hazard-Specific Annexes, it is likely that some of your courses of action for 
threats and hazards will reference cross-cutting functions. In those cases, it is recommended that you 
add a note that additional information on a particular function may be found in the corresponding 
Functional Annex.  

After reviewing and revising each of your annexes for threats, hazards, and functions, be sure to save 
your work (File>Save or CTRL+S).  

Prepare the Draft EOP: Basic Plan 
After preparing the Threat- and Hazard-Specific Annexes, your planning team will develop the Basic Plan 
section of the school EOP.  

Action Steps 
The Basic Plan section provides an overview of the school’s approach to emergency operations and 
often consists of several subsections, as listed below and in Worksheets 4–17 (pg. 9–23). If your school 
or district already has an up-to-date Basic Plan section (provided by the district or otherwise), use that 
Word document instead of Worksheets 4–17 and/or cut and paste it into the worksheets document, 
replacing Worksheets 4–17. Otherwise, you may manually create the Basic Plan section by following the 
directions for each component in the Basic Plan listed below. 

1. Introductory Material  
1.0 Cover Page 

• The Cover Page contains the following information and is the first page of your plan: Title of the 
plan 

• Date 
• The school(s) covered by the plan 

In Worksheet 4 (pg. 9), please cut and paste or write out the Cover Page of your school EOP.  

1.1 Promulgation Document and Signatures 
This document or page contains a signed statement formally recognizing and adopting the school EOP. It 
gives both the authority and the responsibility to school officials to perform their tasks before, during, or 
after an incident, and therefore should be signed by the school administrator or another authorizing 
official. 
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In Worksheet 5 (pg. 10), please cut and paste or write out the Promulgation Document and Signatures 
section of your school EOP. 

1.2 Approval and Implementation 
The Approval and Implementation page introduces the plan, outlines its applicability, and indicates that 
it supersedes all previous plans. It includes a delegation of authority for specific modifications that can 
be made to the plan and by whom they can be made without the school administrator’s signature. It 
also includes a date and should be signed by the authorized school administrator. 

In Worksheet 6 (pg. 12), please cut and paste or write out your school’s or district’s statement formally 
recognizing and adopting the school EOP. 

1.3 Record of Changes 
Each update or change to the plan should be tracked. The Record of Changes page, usually in table 
format, contains—at a minimum—a change number, the date of the change, the name of the person 
who made the change, and a summary of the change. 

In Worksheet 7 (pg. 13), please identify any Record of Changes information, as described above. If your 
plan does not yet contain any changes, you may leave the material included in this worksheet 
untouched. Also, if you prefer to organize your Record of Changes information using different headings, 
or in a different format, you may edit the material located in the table in the worksheet.  

1.4 Record of Distribution 
Districts and schools typically share their final EOPs with community partners who have a role in carrying 
out the plan before, during, or after an emergency. The record of distribution, usually in table format, 
documents the title and the name of the person receiving the plan, the agency to which the recipient 
belongs (either the school office or, if from outside the school, the name of the appropriate government 
agency or private-sector entity), the date of delivery, and the number of copies delivered. 

Please identify any Record of Distribution information, as described above. If you have not yet 
distributed your plan, you may leave the material untouched. Also, if you prefer to organize your Record 
of Distribution information using different headings, or in a different format, you may edit the material 
in Worksheet 8 (pg. 14). 

2. Purpose, Scope, Situation Overview, and Assumptions 
2.1 Purpose 
The purpose sets the foundation for the rest of the school EOP. The basic plan’s purpose is a general 
statement of what the school EOP is meant to do. The statement should be supported by a brief 
synopsis of the basic plan and annexes. 

In Worksheet 9 (pg. 15), please cut and paste or write out the Purpose section of your school EOP. 
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2.2 Scope 
The EOP should explicitly state the scope of emergency and disaster response and the entities (e.g., 
departments, agencies, private sector, citizens) and geographic areas to which the plan applies. 

In Worksheet 9 (pg. 15), please cut and paste or write out the Scope section of your school EOP. 

2.3 Situation Overview 
The situation section explains why a school EOP is necessary and provides a general discussion of the 
threats and hazards that pose a risk to the school—and would result in a need to use this plan—as well 
as the dependencies on parties outside the school for critical resources. 

In Worksheet 9 (pg. 15), please cut and paste or write out the Situation Overview section of your school 
EOP. 

2.4 Planning Assumptions 
The Planning Assumptions section identifies what the planning team assumes to be facts for planning 
purposes in order to make it possible to execute the EOP. During operations, the assumptions indicate 
areas where adjustments to the plan have to be made as the facts of the incident become known. The 
assumptions also provide the opportunity to communicate the intent of senior officials regarding 
emergency operations priorities. 

In Worksheet 9 (pg. 15), please cut and paste or write out the Planning Assumptions section of your 
school EOP. 

3. Concept of Operations (CONOPS) 
The CONOPS section explains in broad terms the school administrator’s intent regarding an operation. 
This section is designed to provide an overall picture of how the school will work to protect students, 
staff members, and visitors, and should perform the following items: 

• Identify those with authority to activate the plan (e.g., school administrators); 
• Describe the process by which the school coordinates with all appropriate agencies, boards, or 

divisions within the jurisdiction; 
• Describe how plans take into account the architectural, programmatic, and communication 

rights of individuals with disabilities and other access and functional needs; 
• Identify other response and support agency plans that directly support the implementation of 

this plan (e.g., city or county EOP, school EOPs from schools co-located on the grounds); 
• Explain that the primary purpose of actions taken before an emergency is to prevent, protect 

from, and mitigate the impact of an emergency on life or property; 
• Explain that the primary purpose of actions taken during an emergency is to respond to the 

emergency and minimize its impact on life or property; and 
• Explain that the primary purpose of actions taken after an emergency is to recover from its 

impact on life or property. 

In Worksheet 10 (pg. 16), please cut and paste or write out the CONOPS section of your school EOP. 
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4. Organization and Assignment of Responsibilities 
The Organization and Assignment of Responsibilities section provides an overview of the broad roles 
and responsibilities of school and district staff, families, guardians, and community partners (e.g., first 
responders, local emergency managers, and public and mental health personnel), and of organizational 
functions during all emergencies. It accomplishes the following: 

• Describes the broad roles and responsibilities of individuals that apply during all emergencies. 
o Individuals whom the planning team may wish to include in this section of the plan are 

principals and other school administrative leaders, teachers, support personnel (e.g., 
instructional aides, counselors, social workers, psychologists, nurses, maintenance staff, 
SROs, cafeteria workers, bus drivers), and parents and guardians. 

o The planning team may also wish to include community-based organizations 
represented in the EOP. 

• Describes informal and formal agreements in place for the quick activation and sharing of 
resources during an emergency (e.g., evacuation locations to a nearby business’s parking lot). 
Agreements may be between the school and response groups (e.g., fire department, police 
department), neighboring schools, organizations, and businesses. 

In Worksheet 11 (pg. 17), please cut and paste or write out the Organization and Assignment of 
Responsibilities section of your school EOP. 

5. Direction, Control, and Coordination 
The Direction, Control, and Coordination section describes the framework for all direction, control, and 
coordination activities in the plan. More specifically, this section should explain the following: 

• The ICS structure;15 
• The relationship between the school EOP and the district, or the broader community’s 

emergency management system; and 
• Who has control of the equipment, resources, and supplies needed to support the school EOP. 

In Worksheet 12 (pg. 18), please cut and paste or write out the Direction, Control, and Coordination 
section of your school EOP. 

6. Information Collection, Analysis, and Dissemination 
The Information Collection, Analysis, and Dissemination section addresses the role of information in the 
successful implementation of the activities that occur before, during, and after an emergency. This 
section should identify the type of information that will be helpful in the successful implementation of 
the activities that occur before, during, and after an emergency, such as the following: 
                                                
 
15 ICS defines the command structure used in an emergency. 
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• Before and during: weather reports, law enforcement alerts, National Oceanic and Atmospheric 
Administration radio alerts, crime reports; and 

• After: mental health agencies’ Websites and hotlines, and emergency management and relief 
agencies’ Websites and hotlines assisting in all aspects of recovery. 

For each of the identified types of information, this section should address the following questions: 

• What is the source of the information? 
• Who analyzes and uses the information? 
• How is the information collected and shared? 
• What is the format for providing the information to those who will use it? 
• When should the information be collected and shared? 

In Worksheet 13 (pg. 19), please cut and paste or write out the Information Collection, Analysis, and 
Dissemination section of your school EOP. 

7. Training and Exercises 
The Training and Exercises section describes the critical training and exercise activities the school will 
use in support of the plan. This includes the core training objectives and frequency to ensure that staff 
members, students, faculty, parents, and community representatives understand roles, responsibilities, 
and expectations. This section also establishes the expected frequency of exercises to be conducted by 
the school. Content may be influenced based on similar requirements at the district and/or local 
jurisdiction level(s). Exercises may range from basic fire and shelter-in-place drills to full-scale 
communitywide drills that realistically portray an emergency event and show the role the school plays in 
school district and municipal planning. 

In Worksheet 14 (pg. 20), please cut and paste or write out the Training and Exercises section of your 
school EOP. 

8. Administration, Finance, and Logistics 
The Administration, Finance, and Logistics section covers general support requirements and the 
availability of services and support for all types of emergencies, as well as general policies for managing 
resources. It should identify and reference policies and procedures that exist outside the plan. This 
section should 

• identify administrative controls (e.g., budget and acquisition policies and procedures) and 
requirements that will be used to provide resource and expenditure accountability; 

• briefly describe how the school will maintain accurate logs of key activities; 
• briefly describe how vital records (e.g., student records) will be preserved (details may be 

contained in a Continuity of Operations functional annex); and 
• identify general policies for keeping financial records, tracking resource needs, tracking the 

source and use of resources, acquiring ownership of resources, and compensating the owners of 
private property used by the school. 
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In Worksheet 15 (pg. 21), please cut and paste or write out the Administration, Finance, and Logistics 
section of your school EOP. 

9. Plan Development and Maintenance 
The Plan Development and Maintenance section describes the overall approach to planning and the 
assignment of plan development and maintenance responsibilities. This section 

• describes the planning process, participants in that process, and how development and revision 
of different sections of the school EOP (Basic Plan and annexes) are coordinated before an 
emergency; 

• assigns responsibility for the overall planning and coordination to a specific position or person; 
and 

• provides for a regular cycle of training, evaluating, reviewing, and updating the school EOP. 

The planning team may want to consider including a review timeline in this section of the plan.  

In Worksheet 16 (pg. 22), please cut and paste or write out the Plan Development and Maintenance 
section of your school EOP. 

10. Authorities and References 
The Authorities and References section provides the legal basis for emergency operations and activities, 
and includes 

• lists of laws, statutes, ordinances, executive orders, regulations, and formal agreements relevant 
to emergencies; and 

• provisions for the succession of decision-making authority and operational control to ensure 
that critical emergency functions can be performed in the absence of the school administrator. 

In Worksheet 17 (pg. 23), please cut and paste or write out the Authorities and References section of 
your school EOP. 

You have now finished the Basic Plan section of your school EOP. Be sure to save your work (File>Save or 
CTRL+S). 

Format the Draft EOP 
Now that your team has developed content for the Basic Plan, the Functional Annexes, and the Threat- 
and Hazard-Specific Annexes of your school EOP, it is now time to format your worksheets into a school 
EOP accordingly. The Interactive Workbook presents a traditional format that can be tailored to meet 
individual school needs. This format is organized into the following sections: 

1. Basic Plan 
2. Functional Annexes 
3. Threat- and Hazard-Specific Annexes 
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Action Steps 
To format plan content in your worksheets document into this school EOP format, please refer to your 
worksheets document (Part B). Save your worksheets document as a new document (File<Save As) titled 
the name of your school EOP. Now delete the cover page of the worksheets document, the Getting 
Started section, the Table of Contents, and Worksheets 1, 2, and 3. Now delete any references to the 
term “worksheet” from your document. You should now have a formatted school EOP. Be sure to save 
your work (File>Save or CTRL+S). 

Review, Approve, and Share the Plan 
Congratulations! Your planning team has just finished the first draft of your school EOP. The content of 
your plan is now ready for your planning team’s review. 

To review your draft plan, invite your planning team and other stakeholders to conduct a review of the 
EOP for plan content and writing conventions. The following EOP Review Checklist may prove useful in 
your review.  Make sure to save a copy of the original plan as well as the revised plan.  

EOP Review Checklist 
School emergency planners should develop emergency operations plans (EOPs) that are useful in 
practice, adhere to basic writing conventions, and comply with applicable laws. Please use the following 
checklist to help your planning team review your school EOP according to these criteria. 
 
Does your school EOP use effective writing practices that clearly express the ideas of the plan? Please 
check all that apply. 
 

☐ The plan summarizes important information with checklists and visual aids, such as maps 
and flowcharts. 

☐ The plan is written clearly, using plain language, avoiding jargon, minimizing the use of 
abbreviations, and using short sentences and the active voice. Qualifiers and vague 
wording only add to confusion. 

☐ The plan uses a logical and consistent structure that makes it easy for readers to grasp 
the rationale for the sequence of the information and to easily scan to retrieve the 
information they need. 

☐ The plan provides enough detail to convey an easily understood plan that details specific 
actions. 

☐ The plan is accessible to diverse audiences and is compatible with appropriate auxiliary 
aids and services to ensure effective communication, such as accessible websites, digital 
text that can be converted to audio or Braille, text equivalents for images, and captioning 
of any audio used in video content. 



 

EOP ASSIST Interactive Workbook 
 
 

40 | P a g e  
 
 

How useful is your plan in practice? Please review the following criteria to determine the 
effectiveness and efficiency of the plan. Please check all that apply. 
 
Adequate 

☐ The plan identifies and addresses critical courses of action. 
☐ The plan can accomplish the assigned function. 
☐ The plan’s assumptions are valid and reasonable. 

 
Feasible 

☐ The school can accomplish the assigned function and critical tasks by using available 
resources. 

☐ The school can accomplish the assigned function and critical tasks within the time 
contemplated by the plan. 

 
Acceptable 

☐ The plan meets the requirements driven by a threat or hazard. 
☐ The plan meets cost limitations. 
☐ The plan meets time limitations. 
☐ The plan is consistent with the law. 

 
Complete 

☐ The plan incorporates all courses of action to be accomplished for the selected threats 
and hazards and identified functions. 

☐ The plan integrates the needs of the whole school community. 
☐ The plan provides a complete picture of what should happen, when, and at whose 

direction. 
☐ The plan estimates time for achieving objectives, with safety remaining as the utmost 

priority. 
☐ The plan identifies success criteria and a desired end state. 
☐ The plan conforms to the planning principles outlined in the Guide for Developing High-

Quality School Emergency Operations Plans. 
 
Compliant 

☐ The plan complies with applicable Federal, State and local requirements, including the 
Americans with Disabilities Act (ADA) and Title VI regulations of the Civil Rights Act of 
1964. 
 

Approving the Plan 
After your planning team has reviewed and finalized the plan, the team should present it to the 
appropriate leadership to obtain official approval. The planning team should then share the plan with 
community partners, such as first responders or local emergency management staff, and other 
stakeholders with a role in the plan, including relevant district, local, regional, and/or state agencies 
with which the plan will be coordinated and other organizations that may use the school building(s). 
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Planning teams may want to share only certain parts of the plans, or modified plans with some 
stakeholders. 

Schools should be careful to protect the plan from those who are not authorized to have it, and should 
consider how they will secure documents shared electronically. Law enforcement agencies and first 
responders have a secured, Web-accessible site available to house copies of plans, building schematics, 
phone contact sheets, and other important details that round out planning. Schools must comply with 
state and local open records laws in storing and protecting the plan. 

Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 16–20: Step 5 
• Pages 23–36: Plan Content 

REMS TA Center. 
• Step 5: Plan Preparation, Review, and Approval. Available at 

http://rems.ed.gov/K12PPStep05.aspx. 
• Basic Plan. Available at http://rems.ed.gov/K12BasicPlan.aspx. 
• Functional Annexes. Available at http://rems.ed.gov/K12FuncAnnex.aspx. 
• Threat- and Hazard-Specific Annexes. Available at 

http://rems.ed.gov/K12ThreatAndHSAnnex.aspx. 

REMS TA Center Resources 
• Active-Shooter Situations. Available at http://rems.ed.gov/K12ActiveShooterSituations.aspx. 
• Communications and Warning Annex Related Resources. Available at 

http://rems.ed.gov/K12ComAndWarningAnnex.aspx. 
• Continuity of Operations Annex Related Resources. Available at 

http://rems.ed.gov/K12CoopAnnex.aspx. 
• EOP EVALUATE. Available at http://rems.ed.gov/EOPinteractivetools.aspx. 
• Evacuation Annex Related Resources. Available at http://rems.ed.gov/K12EvacAnnex.aspx. 
• Family Reunification Annex Related Resources. Available at 

http://rems.ed.gov/K12FamilyRAnnex.aspx. 
• K-12 Online Courses. Available at http://rems.ed.gov/trainings/course_k12.aspx. 

o School EOPs In-Depth: Developing a Bereavement and Loss Annex 
o School EOPs In-Depth: Developing a COOP Annex 
o School EOPs In-Depth: Developing a Food Contamination Annex 
o School EOPs In-Depth: Planning for Infectious Diseases 

• Psychological First Aid for Schools (PFA-S). Available at http://rems.ed.gov/K12PFAS.aspx. 
• Public Health, Medical, and Mental Health Annex Related Resources. Available at 

http://rems.ed.gov/K12PHMandMHAnnex.aspx. 
• Recovery Annex Related Resources. Available at http://rems.ed.gov/K12RecoveryAnnex.aspx. 

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep05.aspx
http://rems.ed.gov/K12BasicPlan.aspx
http://rems.ed.gov/K12FuncAnnex.aspx
http://rems.ed.gov/K12ThreatAndHSAnnex.aspx
http://rems.ed.gov/K12ActiveShooterSituations.aspx
http://rems.ed.gov/K12ComAndWarningAnnex.aspx
http://rems.ed.gov/K12CoopAnnex.aspx
http://rems.ed.gov/EOPinteractivetools.aspx
http://rems.ed.gov/K12EvacAnnex.aspx
http://rems.ed.gov/K12FamilyRAnnex.aspx
http://rems.ed.gov/trainings/course_k12.aspx
http://rems.ed.gov/K12PFAS.aspx
http://rems.ed.gov/K12PHMandMHAnnex.aspx
http://rems.ed.gov/K12RecoveryAnnex.aspx
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• Security Annex Related Resources. Available at http://rems.ed.gov/K12SecurityAnnex.aspx. 
• Specialized Training Packages. Available at http://rems.ed.gov/TrainingPackage.aspx. 

o Infectious Disease Planning 
o Continuity of Operations Planning 
o Developing a Food Contamination Annex 
o Responding to Bereavement and Loss 

• Step 5 Related Resources. Available at http://rems.ed.gov/K12PPStep05.aspx. 
• Threat- and Hazard-Specific Annexes Related Resources. Available at 

http://rems.ed.gov/K12ThreatAndHSAnnex.aspx. 
• Tool Box. Available at http://rems.ed.gov/ToolBox.aspx. 

o Plan Sections and Supporting Materials 

Additional Resources 
DHS (January 2012). Building and Infrastructure Protection Series: Primer to Design Safe School Projects 
in Case of Terrorist Attacks and School Shootings, 2nd Edition. Available at http://www.dhs.gov/bips-07-
primer-design-safe-school-projects-case-terrorist-attacks-and-school-shootings-2nd-edition.  

http://rems.ed.gov/K12SecurityAnnex.aspx
http://rems.ed.gov/TrainingPackage.aspx
http://rems.ed.gov/K12PPStep05.aspx
http://rems.ed.gov/K12ThreatAndHSAnnex.aspx
http://rems.ed.gov/ToolBox.aspx
http://www.dhs.gov/bips-07-primer-design-safe-school-projects-case-terrorist-attacks-and-school-shootings-2nd-edition
http://www.dhs.gov/bips-07-primer-design-safe-school-projects-case-terrorist-attacks-and-school-shootings-2nd-edition
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Step 6: Plan Implementation and Maintenance 
Now that your planning team has an approved EOP, Step 6 will prompt your team to implement the plan 
by training stakeholders; conducting drills and exercises; and reviewing, revising, and maintaining the 
plan. Through the process of reviewing and revising the plan, Step 6 closes the loop in the six-step 
planning process by prompting the planning team to begin the process again. 

Train Stakeholders on the Plan 

The first step in implementing the school EOP is to train everyone involved in the plan on his or her roles 
and responsibilities before, during, and after an emergency. 

Exercise the Plan 

Next, your planning team will need to exercise the plan. Drills and exercises will help stakeholders 
practice their roles and responsibilities before, during, and after an emergency, and provide important 
information to the planning team regarding the effectiveness of the plan. 

Review, Revise, and Maintain the Plan 

Once a plan has been implemented, the planning team will need to update the plan regularly, either in 
part or in whole. 

Closing the Loop in the Planning Process 

Step 6 closes the loop in the six-step planning process and starts the planning cycle over again. A high-
quality plan is one that continually evolves to meet the needs of the school and the surrounding 
community. 

Outcome of Step 6 

At the conclusion of Step 6, your plan will be implemented and the planning cycle will begin again. 

Train Stakeholders on the Plan 
The first step in implementing the school EOP is to train everyone involved in the plan on his or her roles 
and responsibilities before, during, and after an emergency. Your planning team should consider 
conducting the following activities when training stakeholders on the plan. 

Hold a meeting. At least once a year, hold a meeting to educate all parties on the plan. 

Visit evacuation sites. Show involved parties not only where evacuation sites are located, but also 
where specific areas—such as reunification areas, media areas, and triage areas—will be located. 
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Give involved parties appropriate and relevant literature on the plan, policies, and procedures. It may 
also be helpful to provide all parties with quick reference guides on key courses of action.16 

Post key information throughout the buildings. It is important that students and staff members are 
familiar with and have easy access to information such as evacuation routes and shelter-in-place 
procedures and locations. Communicate key information to individuals with disabilities and other access 
and functional needs by distributing the materials in an accessible format. 

Familiarize students and staff with community partners. Bring community partners (e.g., law 
enforcement officers, fire officials, and EMS personnel) to the school to talk about the plan in order to 
help students and staff members feel more comfortable working with these partners. 

Train staff members on the skills necessary to fulfill their roles. Staff members will be assigned specific 
roles in the plan and in support of ICS that require special skills and training, such as first aid, threat 
assessment, and provision of personal assistance services for individuals with disabilities and other 
access and functional needs. Substitute teachers must also be trained on their roles in the plan. 

Exercise the Plan 
The more a plan is practiced and stakeholders are trained on the plan, the more effectively they will be 
able to act before, during, and after an emergency to lessen the impact on life and property. Exercises 
provide opportunities to practice with community partners (e.g., first responders, local emergency 
management personnel), as well as to identify gaps and weaknesses in the plan. The exercises below 
require increasing amounts of planning, time, and resources. Ideally, schools will create an exercise 
program, building from a tabletop exercise up to a more advanced exercise, like a functional exercise. 

• Tabletop exercises are small-group discussions that walk through a scenario and the courses of 
action a school will need to take before, during, and after an emergency to lessen the impact on 
the school community. This activity helps assess the plan and resources, and facilitates an 
understanding of emergency management and planning concepts. 

• During drills, school personnel and community partners (e.g., first responders, local emergency 
management staff) use the actual school grounds and buildings to practice responding to a 
scenario. 

• Functional exercises are similar to drills but involve multiple partners; some may be conducted 
district-wide. Participants react to realistic simulated events (e.g., a bomb threat, or an intruder 
with a gun in a classroom), and implement the plan and procedures using the ICS. 

• Full-scale exercises are the most time-consuming activity in the exercise continuum and are 
multiagency, multijurisdictional efforts in which all resources are deployed. This type of exercise 
tests collaboration among the agencies and participants, public information systems, 

                                                
 
16 Your school planning team should consider preparing translated versions of these reference guides to 
support individuals with LEP. 
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communications systems, and equipment. An Emergency Operations Center is established by 
either law enforcement or fire services, and the ICS is activated. 

Before making a decision about how many and which types of exercises to implement, a school should 
consider the costs and benefits of each, as well as any state or local requirements. 

To effectively execute an exercise 

• include community partners such as first responders17 and local emergency management staff; 
• communicate information about the exercise in advance to avoid confusion and concern; 
• exercise under different and non-ideal conditions (e.g., times of day, weather conditions, points 

in the academic calendar, absence of key personnel, and various school events); 
• be consistent with common emergency management terminology, as found at 

http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf; 
• debrief and develop an after-action report that evaluates results, identifies gaps or shortfalls, 

and documents lessons learned; and 
• discuss how the school EOP and procedures will be modified, if needed, and specify who has the 

responsibility for modifying the plan. 

Review, Revise, and Maintain the Plan 
Once your planning team has implemented the school EOP, your team will need to update the plan 
regularly. 

Reviews should be a recurring activity. Planning teams should establish a process for reviewing and 
revising the plan. Many schools review their plans annually. In no case should any part of a plan go for 
more than 2 years without being reviewed and revised. 

Some schools have found it useful to review and revise portions instead of reviewing the entire plan at 
once. Schools may consider reviewing a portion each month or at natural breaks in the academic 
calendar. Certain events will also provide new information that will be used to inform the plan. Schools 
should consider reviewing and updating their plans or sections of their plans after 

• actual emergencies; 
• changes have been made in policy, personnel, organizational structures, processes, facilities, or 

equipment; 
• formal updates of planning guidance or standards have been finalized; 
• formal exercises have taken place; 
• changes in the school and surrounding community have occurred; 
• threats or hazards change or new ones emerge; or 

                                                
 
17 Law enforcement officers, EMS practitioners, and fire department personnel. 

http://rems.ed.gov/docs/Glossary%20of%20Key%20Terms%208.8.2014.pdf


 

EOP ASSIST Interactive Workbook 
 
 

46 | P a g e  
 
 

• ongoing assessments generate new information. 

The planning team should ensure that all community partners (e.g., first responders, local emergency 
management staff) have the most current version of the school EOP. 

Action Steps 
As your planning team completes Step 6, there may be occasions when the team will want to revisit Step 
5 to update portions of the Basic Plan that relate to Step 6 activities. For example, your planning team 
may wish to update the Training and Exercises or the Plan Development and Maintenance sections of 
the Basic Plan as your team implements the plan in Step 6. Additionally, the introductory materials will 
need to include continuous records of changes and distribution.   

Thank You for Using the Interactive Workbook 
Your planning team has just completed the six-step planning process for developing a high-quality 
school EOP. Your team deserves congratulations for the important strides you have taken to improve 
emergency management at your school! 

Although completing the six-step planning process is a significant milestone, it does not mean that your 
work is done. High-quality school emergency planning is a continuous, cyclical process, and completing 
Step 6 starts the planning cycle over again. Remember: a high-quality plan is one that continually 
evolves to meet the needs of the school and the surrounding community. 

Thank you for using the Interactive Workbook. 

Supplemental Resources 
Guidance 
ED OSHS (June 2013). Guide for Developing High-Quality School Emergency Operations Plans. Available 
at http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf. 

• Pages 20–23: Step 6 

REMS TA Center. 
• Step 6: Plan Implementation and Maintenance. Available at 

http://rems.ed.gov/K12PPStep06.aspx. 

REMS TA Center Resources 
• Step 6 Related Resources. Available at http://rems.ed.gov/K12PPStep06.aspx. 
• Toolbox. Available at http://rems.ed.gov/ToolBox.aspx. 

o Training Materials 
o After-Action Reports 
o Materials Supporting Drills, Tabletops, and Other Exercises 

Additional Resources 
DHS FEMA (April 2013). Homeland Security Exercise and Evaluation Program. Available at 
http://www.fema.gov/media-library-data/20130726-1914-25045-8890/hseep_apr13_.pdf. 

http://rems.ed.gov/docs/REMS_K-12_Guide_508.pdf
http://rems.ed.gov/K12PPStep06.aspx
http://rems.ed.gov/K12PPStep06.aspx
http://rems.ed.gov/ToolBox.aspx
http://www.fema.gov/media-library-data/20130726-1914-25045-8890/hseep_apr13_.pdf
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